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This help file contains information that you might find useful when first installing WinZip®.    Just click on 
any of the topics below.
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The Wizard and Classic interfaces

Ordering Information

WinZip Standard License

WinZip Evaluation License

If you are looking for the main help on how to use WinZip, click one of these two topics:

WinZip Wizard help

WinZip Classic interface help



WinZip Installation
The Setup Wizard will guide you through the simple WinZip installation procedure.

The Wizard will ask a few questions during setup.    Most users can simply accept all of the recommended
settings by clicking Next.    Advanced users can customize installation by changing options as they 
appear.

If you are interested in information on installing WinZip site licenses in a networked environment, please 
see the web page http://www.winzip.com/site_install.htm.



Printing the Quick Start Guide
The Quick Start Guide provides valuable information to help you get started using WinZip®.    To print the 
Guide, click Print Quick Start during the installation process.

In the Print dialog,
· Use the Name dropdown list to select the printer you want to use.
· Click Properties to change printer settings such as print quality and paper type.
· Click OK to print the Quick Start Guide, or Cancel if you do not want to print it.

After installation, you can view the Quick Start Guide at any time by clicking Help on any Wizard panel, 
clicking the help Contents button, and then clicking The WinZip Quick Start Guide. 



The Wizard and Classic Interfaces

The two WinZip® interfaces
WinZip can be used with two different interfaces: the WinZip Classic interface or the WinZip Wizard.    
Both interfaces are included in all versions of WinZip.    One click switches from the Wizard to the Classic 
interface and vice versa.

· The WinZip Wizard interface is ideal if you want to know as little about Zip files as possible or to 
just "get started" with the files you have downloaded.    With the Wizard, you simply click the 
"Next" button a few times, and presto, your files are zipped, unzipped, or installed.    When you 
want to use more advanced zipping features, you can easily switch to the Classic interface.

· The award-winning WinZip Classic interface features tight integration with the Windows 95/98/NT 
shell and versatile drag and drop facilities. It is great if you are comfortable using Windows and 
the Explorer, or want to use advanced zipping features.

When you install WinZip you must choose which interface WinZip will use when it starts up.    But 
whichever you choose, remember that you can always change your mind later and that it is easy to switch
interfaces any time.
How do I …



· choose a WinZip interface?

· switch interfaces while I'm using WinZip?

· change the interface WinZip will use when it starts up?



How do I choose a WinZip interface?
During the WinZip setup procedure you are asked to select either the WinZip Wizard interface or the 
WinZip Classic interface.

Look at these two lists and decide which one seems more like you:

You might prefer the Wizard if
· you are new to computers.
· you are unfamiliar with the Windows operating system.
· you don't know much about Zip files, and don't want to.
· you just want to be able to deal with downloaded archives with a minimum of fuss.

You might prefer the Classic interface if
· you are an experienced computer user.
· you are comfortable using Windows and Zip files.
· you know how to use Windows Explorer.
· you need finer control over what goes into your Zip files, and what happens to files after they've 

been zipped.

Whichever one you choose, remember that you can always switch interfaces any time or change the 
interface WinZip uses when it starts up.



How do I switch interfaces while I'm using WinZip?

Whichever interface you're using, the other interface is always just one click away.

To switch from the WinZip® Wizard to the Classic interface

While in the Wizard, switch to the Classic interface by clicking on the WinZip Classic button.



To switch from the Classic interface to the WinZip Wizard

While using the Classic interface, switch to the Wizard by clicking on the Wizard toolbar button, or choose
the Wizard entry in the File menu.



How do I change the interface WinZip will use when it starts?
Naturally enough, WinZip® must always start up using one of the two interfaces, either Classic or the 
Wizard.    You have to pick one of these when you install WinZip, but it's easy to change your mind later.    
Here's how:
To start up in the WinZip Wizard

· If you're currently using the Classic interface:
1. Choose Configuration from the Options menu.
2. Click the Miscellaneous tab.
3. Check the Next time start with the Wizard interface checkbox.
4. Click OK.

· If you're currently in the WinZip Wizard:
1. If necessary, click Next or Back to get to the Welcome to WinZip panel.
2. Click Options and then click on the Misc tab.
3. Click Next time start WinZip with the Wizard interface.
4. Click OK.

To start up in the Classic interface
· If you're currently using the Classic interface:

1. Choose Configuration from the Options menu.
2. Click the Miscellaneous tab.
3. Uncheck the Next time start with the Wizard interface checkbox.
4. Click OK.

· If you're currently in the WinZip Wizard:
1. If necessary, click Next or Back to get to the Welcome to WinZip panel.
2. Click Options and then click on the Misc tab.
3. Click Next time start WinZip with the Classic interface.
4. Click OK.

Tip: there's an even easier way to change your startup interface: just switch interfaces to the one you 
want to use at startup and then close WinZip.    WinZip will display a dialog asking you to pick the 
interface to use next time; simply click the button for the desired interface.



The WinZip Quick Start Guide
The WinZip® Quick Start Guide provides helpful information about getting started with WinZip.    You can 
print or view the Quick Start Guide from this panel.

Click Print Quick Start to print the Quick Start Guide.

Click View Quick Start to view the Quick Start Guide using Windows help.

Click Next when you are ready to continue.



Printing the Quick Start Guide
The Quick Start Guide provides valuable information to help you get started using WinZip®.    To print the 
Guide, click Print Quick Start during the installation process.

In the Print dialog,
· Use the Name dropdown list to select the printer you want to use.
· Click Properties to change printer settings such as print quality and paper type.
· Click OK to print the Quick Start Guide, or Cancel if you do not want to print it.

After installation, you can view the Quick Start Guide at any time by clicking Help on any Wizard panel, 
clicking the help Contents button, and then clicking The WinZip Quick Start Guide.



Express or custom setup
You can install WinZip® using either express or a custom setup.    Your choice affects only the initial 
settings of certain WinZip options; it does not affect where WinZip will be stored or how much disk space 
is used.    Whichever you choose, you can change any option settings any time.

To continue, click either Express setup or Custom setup and then click Next.
Express installation
Express installation installs WinZip using the most commonly chosen options.    For example, WinZip is 
associated with archives, and WinZip icons are placed in the Start menu and on your desktop.    Express 
installation is easiest and best for most users.

Custom installation
The custom installation, recommended for advanced users only, allows you to tailor initial WinZip option 
settings to your needs.



Explorer configuration
The Explorer Configuration panel allows you to select which optional Explorer-related WinZip® features 
you would like to enable.    Simply check the options you want and click Next.
The options are:

· Associate WinZip with archives: Windows will use WinZip to open archives from My Computer, 
Windows Explorer, most e-mail programs, etc.

· Explorer shell extension: WinZip's Explorer context menus are enabled, and you can use drag 
and drop to zip and unzip without leaving Explorer.

· Non-cascaded WinZip context menu items: WinZip's Explorer context menu items will appear 
in the main Explorer context menu.    If unchecked, the menu items will appear in a sub-menu.

· Display icons on context menus: A small WinZip icon is displayed to the left of WinZip's 
Explorer context menu items.

· Enable Zip & E-Mail on context menus: WinZip's "Zip & E-Mail" entry appears in Explorer 
context menus.    This entry allows you to easily compress and e-mail documents and other files 
directly from Explorer.

· Include WinZip in Start menu: WinZip appears in the taskbar's Start menu.
· Include WinZip on desktop: a WinZip icon appears on your desktop.



Other options
The Other Options panel control a few additional WinZip® options.    Set the options as desired, then click 
Next.
The options are:

· External programs: a few optional WinZip operations require external programs.    These include
operations such as virus scanning, viewing files with no Windows associations, and working with 
certain types of non-Zip archives.    You can configure these programs now by clicking Program 
Locations, or you can wait until you need them and configure at that time by choosing 
Configuration from the Options menu.

· Create WinZip program group and icons: Setup will create a window containing WinZip icons.
· Create icon for WinZip Self-Extractor Personal Edition: Setup will create an icon for the Self-

Extractor.    This program, included with WinZip, allows you to create self-extracting Zip files that 
can be unzipped by users who do not have access to WinZip or another Zip-related program.



Favorite folders
The Search for Favorite Zip Folders panel controls how Setup searches for your Favorite Zip Folders.

Favorite Zip Folders is a WinZip® feature that helps you to organize your Zip files by identifying folders on
your system that are likely to contain Zip files.    Your Zip files are then presented in one convenient list, 
making it easier to locate all Zip files, regardless of where they came from or where they are stored.

Choose the search method you prefer, then click Next.    Regardless of which option you pick now, you 
can always reorganize your Favorite Zip Folders by clicking Options from the Wizard's Welcome panel.

The options are:
· Search Entire Hard Disk: Searches all folders on your hard disk for Zip files.    This is the 

recommended option.
· Quick Search: Searches for certain specific folders that commonly contain Zip files.    This option 

is faster but not as comprehensive.



Wizard setup complete
Congratulations!    The WinZip® Wizard is installed and ready to use.

· Click Next to start the Wizard.
· Click Close to close WinZip.

Here are some of the ways you can start WinZip in the future:
· From the Start menu, click Programs, then WinZip, then WinZip again.
· Click WinZip from the Start menu.
· Double click the WinZip desktop icon.
· Double click a Zip file in a My Computer or Windows Explorer window, or double click a Zip file e-

mail attachment.
· Drag and drop a Zip file on the WinZip desktop icon.



Installation is complete
Congratulations!    WinZip® is installed and ready to use.

· Click Finish to close WinZip Setup and start WinZip.
· Click Close to close WinZip Setup.

Here are some of the ways you can start WinZip in the future (assuming that you enabled all of the 
Explorer options):

· From the Start menu, click Programs, then WinZip, then WinZip again.
· Click WinZip from the Start menu.
· Double click the WinZip desktop icon.
· Double click a Zip file in a My Computer or Windows Explorer window, or double click a Zip file e-

mail attachment.
· Drag and drop a Zip file on the WinZip desktop icon.



Associations
Associations help Windows to know when to use WinZip with your files.    For example, because WinZip is
associated with Zip files, Windows will always use WinZip to open Zip files.    For best operation, WinZip 
should be associated with all types of archives that it supports.

Click Next to automatically associate WinZip with all supported archive types.

Click Associations if you would like to examine the associations that WinZip will create and specify 
which associations you want to enable.



WinZip 8.0 Ordering Information
This ordering information applies to the English language version of WinZip® 8.0.    All disk orders are 
sent by postal mail (airmail outside North America) and leave our office within two business days after 
they are received; there is no additional charge for postage. 

All orders are subject to the WinZip License Agreement.

Immediate Online Delivery
Immediate online delivery of registered copies of WinZip is available for credit card orders placed via the 
Internet using the Order link at the WinZip web site:

http://www.winzip.com

You can place orders for delivery by postal mail (or airmail outside North America) using the Internet order
forms or as described below.

Ordering by Check
To order by check, send a completed order form and a check payable to WinZip Computing, Inc., P.O. 
Box 540, Mansfield, CT 06268 USA.    Payments must be in US dollars drawn on a US bank, or you can 
send international postal money orders in US dollars.    Click here to view a ready-to-print Order Form.

Credit Card Orders
You can place secure credit card orders on the Internet using the Order link on the WinZip web site:

http://www.winzip.com    

For information on credit card ordering by phone, fax, or postal mail, see Credit Card Ordering.

Purchase Orders
For information on using purchase orders see Purchase Orders.

Additional Ordering Options Outside the USA and Canada
For information on local registration see Ordering Options Outside the USA and Canada.

Site licenses
A site license for WinZip entitles an organization to receive one copy of the distribution package and 
duplicate the software as necessary for use within the organization on the specified number of computers.
See the table below for site license pricing. For higher quantity pricing, please send e-mail to 
sitesales@winzip.com or fax a request to WinZip Computing at 1-860-429-3542.

Pricing
WinZip Single Copy $29 each

WinZip Site Licenses (includes distribution disk):

2 to 9 computers: $22 each

10 to 24 computers: $17 each

25 to 49 computers: $14 each

50 to 99 computers: $10 each

100 to 199 computers: $7 each

200 to 499 computers: $6 each

500 to 999 computers: $4 each

Prices guaranteed through July 2001.





WinZip Standard License
WinZip® Copyright © 1991-2000 by WinZip Computing, Inc.
All rights reserved.

This license applies to the standard-licensed version of WinZip.    If you have an evaluation version of 
WinZip, see the section titled WinZip Evaluation License.

WinZip License
WinZip Computing, Inc. 
You should carefully read the following terms and conditions before using this software.    Unless you have
a different license agreement signed by WinZip Computing, Inc. ("WCI") your use, distribution, or 
installation of this copy of WinZip indicates your acceptance of this License.    

If you do not agree to any of the terms of this License, then do not install, distribute or use this copy of 
WinZip.    If you paid WCI or an authorized WCI distributor for this copy individually, you may return it 
unused, within thirty (30) days after purchase, for a full refund of your payment.

This copy of WinZip may either be used by a single person who uses the software personally on one or 
more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not 
both. This is not a concurrent use license.

You may access this copy through a network, provided that you have obtained an individual WinZip 
license for each workstation that will access WinZip through the network.    For instance, if 8 different 
workstations will access WinZip on the network, each workstation must have its own WinZip license, 
regardless of whether they use WinZip at different times or concurrently.

This copy includes WinZip Self-Extractor Personal Edition, which may be used to create an unlimited 
number of freely distributable, royalty-free self-extracting Zip files. These self-extracting Zip files contain, 
among other things, a portion of WinZip Self-Extractor Personal Edition, including copyrighted software, 
proprietary notices, and identifying information (the "Extraction Software"). You may not alter or modify the
Extraction Software, nor give anyone permission to do so.

This software, and all accompanying files, data and materials, are distributed "AS IS" and with no 
warranties of any kind, whether express or implied.    In particular, there is no warranty for the optional
virus scanning feature. (WinZip does not scan for viruses, it simply runs external programs that claim to 
perform this function.)     Good data processing procedure dictates that any program be thoroughly tested 
with non-critical data before relying on it.    The user must assume the entire risk of using the program.    
This disclaimer of warranty constitutes an essential part of the agreement. 

Any liability of WCI will be limited exclusively to refund of purchase price.    In addition, in no event
shall WCI, or its principals, shareholders, officers, employees, affiliates, contractors, subsidiaries, 
or parent organizations, be liable for any incidental, consequential, or punitive damages 
whatsoever relating to the use of WinZip, or your relationship with WCI.

In addition, in no event does WCI authorize you to use WinZip in applications or systems where 
WinZip's failure to perform can reasonably be expected to result in a significant physical injury, or
in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold WCI 
harmless from any claims or losses relating to such unauthorized use.

This Agreement is the complete statement of the Agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This Agreement shall be governed by the laws of the State of    Connecticut.    Exclusive 
jurisdiction and venue for all matters relating to this Agreement shall be in courts and fora located in the 
State of Connecticut, and you consent to such jurisdiction and venue.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 



disassemble or create derivative works based on WinZip. You may not make access to WinZip available 
to others in connection with a service bureau, application service provider, or similar business, or use 
WinZip in a business to provide file compression, decompression, or conversion services to others. There
are no third party beneficiaries of any promises, obligations or representations made by WCI herein.



WinZip Evaluation License
WinZip® Copyright © 1991-2000 by WinZip Computing, Inc.
All rights reserved.

This license applies to the evaluation version of WinZip.    If you do not have an evaluation version of 
WinZip, see the section titled WinZip Standard License. 

WinZip License
Evaluation Version
WinZip Computing, Inc. 
By using, copying, transmitting, distributing or installing WinZip, you agree to all of the terms of this 
License.    If you do not agree to any of the terms of this License, then do not use, copy, transmit, 
distribute, or install WinZip.

This is not free software.    Subject to the terms below, you are hereby licensed by WinZip Computing, Inc.
("WCI") to use this software for evaluation purposes without charge for a period of 21 days.    If you use 
this software after the 21 day evaluation period a registration fee of $29 is required.    Payments must be 
in US dollars drawn on a US bank, and should be sent to WinZip Computing, Inc., P.O. Box 540, 
Mansfield, CT 06268, USA.    See the WinZip web site at http://www.winzip.com for information about 
online ordering and quantity discounts. 

Unregistered use of WinZip or WinZip Self-Extractor Personal Edition after the 21-day evaluation period is
in violation of U.S. and international copyright laws.

You may, without making any payment to WCI:
a) give exact copies of this evaluation version of WinZip personally to anyone, except for the 

purpose of extending their 21 day evaluation period;
b) distribute exact copies of this evaluation version of WinZip, if done exclusively through electronic 

channels; and 
c) make as many exact copies of this evaluation version of WinZip as you wish, for purposes of 

distribution as described in (a) and (b) above.

You are specifically prohibited from charging, or requesting donations, for any copies, however 
made, and from distributing such copies with other products of any kind, commercial or 
otherwise, without prior written permission from WCI. WCI reserves the right to revoke the above 
distribution rights at any time, for any or no reason.

Self-extracting Zip files created by WinZip Self-Extractor Personal Edition (distributed as part of the 
WinZip evaluation package) contain, among other things, a portion of WinZip Self-Extractor, including 
copyrighted software, proprietary notices, and identifying information (the "Extraction Software").    You 
may not alter or modify the Extraction Software, nor give anyone permission to do so. Under no 
circumstances are you licensed to distribute self-extracting Zip files created by the evaluation 
version of WinZip Self-Extractor Personal Edition.

This software, and all accompanying files, data and materials, are distributed "AS IS" and with no 
warranties of any kind, whether express or implied.    In particular, there is no warranty for the optional
virus scanning feature. (WinZip does not scan for viruses, it simply runs external programs that claim to 
perform this function.)     Good data processing procedure dictates that any program be thoroughly tested 
with non-critical data before relying on it.    The user must assume the entire risk of using the program.    
This disclaimer of warranty constitutes an essential part of the agreement.    In no event shall WCI,
or its principals, shareholders, officers, employees, affiliates, contractors, subsidiaries, or parent 
organizations, be liable for any incidental, consequential, or punitive damages whatsoever 
relating to the use of WinZip, or your relationship with WCI.

In addition, in no event does WCI authorize you to use WinZip in applications or systems where 



WinZip's failure to perform can reasonably be expected to result in a significant physical injury, or
in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold WCI 
harmless from any claims or losses relating to such unauthorized use.

This Agreement is the complete statement of the Agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This Agreement shall be governed by the laws of the State of    Connecticut.    Exclusive 
jurisdiction and venue for all matters relating to this Agreement shall be in courts and fora located in the 
State of Connecticut, and you consent to such jurisdiction and venue.

All rights of any kind in WinZip which are not expressly granted in this License are entirely and exclusively
reserved to and by WCI.    You may not rent, lease, modify, translate, reverse engineer, decompile, 
disassemble or create derivative works based on WinZip. You may not make access to WinZip available 
to others in connection with a service bureau, application service provider, or similar business, or use 
WinZip in a business to provide file compression, decompression, or conversion services to others. There
are no third party beneficiaries of any promises, obligations or representations made by WCI herein.



WinZip 8.0 Order Form/Invoice
To print this order form, select Print Topic from the File pull-down menu.
This ordering information only applies to the English language version of the product.    To order by check,
send this completed order form and a check (in US dollars drawn on a US bank) payable to WinZip 
Computing, Inc., P.O. Box 540, Mansfield, CT 06268 USA.    All orders are subject to the WinZip® License
Agreement.

Customer information is considered confidential and will not be shared or distributed to any third party.
WinZip Single Copy _____ at $29 each = __________

WinZip Site Licenses (includes distribution disk):

2 to 9 computers: _____ at $22 each = __________

10 to 24 computers: _____ at $17 each = __________

25 to 49 computers: _____ at $14 each = __________

50 to 99 computers: _____ at $10 each = __________

100 to 199 computers: _____ at $7 each = __________

200 to 499 computers: _____ at $6 each = __________

500 to 999 computers: _____ at $4 each = __________

Connecticut Residents add 6% sales tax: __________

Total payment: __________

Prices are in US dollars and are guaranteed through July 2001.

If you need a quote for higher quantity site licenses, please send e-mail to 
sitesales@winzip.com

Date: _______________________________________________________

Name: _______________________________________________________

Company: _______________________________________________________

Shipping Address: _______________________________________________________

_______________________________________________________

City, State, Zip: _______________________________________________________

Country: _______________________________________________________

Day Phone: _______________________________________________________

E-Mail address: _______________________________________________________
How did you hear

about WinZip?
_______________________________________________________

Comments:

WinZip 8.0 Credit Card Order Form



To print this order form, select Print Topic from the File pull-down menu.
Note: this ordering information is for the English version of WinZip®.    You can place credit card orders by
phone, fax, or postal mail through DigiBuy, a credit card ordering service. The best way to reach DigiBuy 
is by phone at 1-877-724-4600 (toll free; U.S. only) or 1-612-253-8488.    You can also send credit card 
orders via fax to 1-203-699-0780 or by mail to DigiBuy Customer Service, PO Box 339, Cheshire, CT 
06410 USA.    Please be sure to include a completed credit card order form (below) with your order.

All orders are subject to the WinZip License Agreement.    Prices are in US dollars and are guaranteed 
through July 2001.

WinZip Computing, Inc. cannot be reached at the numbers above.    These numbers are for 
DigiBuy, a third-party service that only takes credit card orders.

Any questions about the status of the shipment of an order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, etc., should be directed to WinZip 
Computing. You can send e-mail to help@winzip.com; our goal is to respond to all e-mail inquiries within 
one business day. You can also send postal mail to WinZip Computing, P.O. Box 540, Mansfield, CT 
06268, USA.    All prices are in US dollars.

WinZip Single Copy _____ at $29 each = __________

WinZip Site Licenses (includes distribution disk):

2 to 9 computers: _____ at $22 each = __________

10 to 24 computers: _____ at $17 each = __________

25 to 49 computers: _____ at $14 each = __________

50 to 99 computers: _____ at $10 each = __________

100 to 199 computers: _____ at $7 each = __________

200 to 499 computers: _____ at $6 each = __________

500 to 999 computers: _____ at $4 each = __________

CT (6%), MN (6.5%), and WA (8.6%) residents add sales tax: __________

Total payment: __________

Date: __________________________________________________

Credit Card: [      ] MasterCard            [      ] VISA              [      ] AMEX                [      ] 
Discover

Credit Card #: __________________________________________________

Expiration Date: __________________________________________________

Name On Card: __________________________________________________

Signature: __________________________________________________

Name: __________________________________________________

Company: __________________________________________________

Billing Address: __________________________________________________

City, State, Zip: __________________________________________________

Country: __________________________________________________

Day Phone: __________________________________________________

E-Mail address: __________________________________________________
How did you hear

about WinZip?
                          
__________________________________________________





Purchase Orders
Purchase orders (net 30 days) are accepted from government and accredited educational institutions and 
major corporations, provided that they are submitted on purchase order forms with a purchase order 
number. Please be sure to include the standard WinZip® order form with your purchase order, and send it
to WinZip Computing, P.O. Box 540, Mansfield, CT 06268 USA, or fax it to 1-860-429-3542.



Ordering Options Outside the USA and Canada
In addition to the aforementioned registration options you can contact the following distributors for local 
registration and support.    Dealer prices may vary.

German Version: For a German language version of WinZip®, please contact H.C. Top Systems, B.V., 
Postfach 13 30, D-47630 Straelen, Germany, phone: 08000-946-947 (toll free; Germany only) or +31-(0)-
77-306-8100, fax: +31-(0)-77-306-8130, visit their website or send e-mail to support@winzip.de.

French Version: For a French language version of WinZip, please contact AB Soft, Park Burospace #14, 
91572 Bievres Cedex, France, phone: +33-(0)-1-69-33-7000.

Japanese Users: For a version of WinZip that includes a Japanese Help file, contact P. & A. Inc., No.3 
Hoko Bldg. 6F, 2-29-13 Akebono, Tachikawa, Tokyo 190-0012 Japan, phone: +81-(0)-042-525-9501, fax: 
+81-(0)-042-525-9502, e-mail: sales@panda.co.jp or PAF02461 on NiftyServe.    P&A also maintains 
websites in Japan and the USA.

If you purchase WinZip directly from WinZip Computing, Inc., be sure to contact WinZip Computing for 
support, not your local reseller.



Why aren't WinZip's e-mail features working for me?
WinZip® support for e-mailing archives requires that you have an e-mail program installed and properly 
configured. If there is a problem with your e-mail configuration, then these features will either be disabled 
or nonfunctional.

WinZip uses a Windows feature called MAPI (Mail Applications Program Interface) to "talk" to your e-mail 
program. MAPI is a standard interface that allows WinZip and other programs to instruct your e-mail 
program to create a new message, attach a file to it, etc.    If MAPI is not properly configured on your 
system, then WinZip and other programs can't create e-mail for you.    "Properly configured" means that:

· you have a MAPI-compliant e-mail program installed, and
· the e-mail program properly supports the "Simple MAPI" interface that WinZip requires, and
· the e-mail program is configured to be the default e-mail program (sometimes called the "default 

MAPI client").

Examples of popular MAPI-compliant e-mail programs include (but are not limited to) Outlook, Outlook 
Express, and Eudora.

AOL versions 4.0 and 5.0 are not MAPI-compliant and therefore do not support WinZip's e-mail features.

If you are having difficulty e-mailing your archives with WinZip, we have tips for some popular 
configurations available on our website.    Please visit http://www.winzip.com/xmapi.htm.



The WinZip Quick Start Guide
This Quick Start Guide introduces some file compression terms, describes some of the initial steps in 
installing WinZip, and provides a first look at using some WinZip® features. For additional information, 
see the online tutorials that come with WinZip, the WinZip online Help file, and visit the WinZip web site at
http://www.winzip.com.

What is an Archive or Zip file, anyway?
Zip files are "archives" used for storing and distributing files, and can contain one or more files.    Usually 
the files "archived" in a Zip are compressed to save space. Zip files are often used to:

· Distribute files on the Internet: Only one Zip file transfer operation (download) is required to 
obtain all related files and file transfer is quicker because the archived files are compressed.

· Send a group of related files to an associate: When you distribute the collection of files as an 
archive you benefit from the file grouping and compression as well.

· Save disk space: If you have large files that are important but seldom used, such as large data 
files, simply compress these files into an archive and then unzip (or "extract") them only when 
needed.

What does WinZip do?
WinZip makes it easy for Windows users to work with archives.    WinZip features an intuitive point-and-
click drag-and-drop interface for viewing, running, extracting, adding, and deleting files in archives with a 
standard Windows interface, and also provides a Wizard interface that further simplifies the process of 
working with Zip files.

About WinZip's Setup Options
During the WinZip setup procedure you are asked to select either the WinZip Wizard interface or the 
WinZip Classic interface.

· WinZip Wizard: If you are new to computers, or unfamiliar with the Windows operating system, 
then you should first try using the WinZip Wizard to open and create your Zip files.

· WinZip Classic: The more powerful WinZip Classic interface is recommended if you are an 
experienced computer user, comfortable with using Windows and Zip files.

In the following section we will describe the WinZip Wizard Setup screens. With either interface, the setup
panels provide information about the options offered. Whichever setup option you choose, you can easily 
switch between the two interfaces at any time with a single click, and you can always change the default 
settings later.

Installing the WinZip Wizard
We will refer to the on-screen panels using the title that appears at the top of each panel.    

1. In the WinZip Setup panel, choose Start with the WinZip Wizard and click Next. The Search for 
Favorite Zip Folders panel will appear.

2. In the Search for Favorite Zip Folders panel, choose Search Entire Hard Disk so the Wizard can
search your system for Zip files (this is the recommended option).    You will see the search 
progress, and then a panel that says something like "17 folders were added to your 'Favorite Zip 
Folders'".    Click Next. 

3. The Wizard will open an Explorer window displaying the WinZip program group icons. Click Next 
to continue, and the Wizard Welcome panel will appear.

4. In the Wizard Welcome panel, click Next again, and the Select Activity panel will appear.

That's it, you have installed WinZip, and you're ready to begin using the WinZip Wizard. The sections 
below describe using the Wizard for unzipping and zipping files.



Using the WinZip Wizard
If you have just installed WinZip and selected the WinZip Wizard interface, then at this point the Select 
Activity panel is on the screen.

If you have previously installed WinZip, you can start a WinZip session using the WinZip program item in 
the WinZip program group, the Start menu, or the WinZip icon on your desktop.

Here is a brief introduction to the features of the WinZip Wizard.

Quick Unzipping with the WinZip Wizard
1. In the Select Activity panel, choose Unzip or install from an existing Zip file and click Next. 

The Select Zip File panel will appear. 
2. In the Select Zip File panel, click on the Zip file you want to work with and click Next. The Unzip 

panel will appear.
3. In the Unzip panel, click Unzip Now to open the files in the archive. The WinZip Wizard will open 

a Windows Explorer window showing the unzipped files.

That's it, you've just unzipped (extracted) a Zip file using the WinZip Wizard. You can now work with the 
unzipped files, or click Next to choose another activity within WinZip, or close the WinZip Wizard window.

Quick Zipping with the WinZip Wizard
1. In the Select Activity panel, choose Create a new Zip file and click Next.
2. In the Choose Zip Name panel, type the name you want to use for your new Zip file and click 

Next. For example, if you are creating a Zip file that will contain some files related to yearly 
reports, you might type "1999 reports" as the name for your Zip file.

3. In the Select Files panel, click Add files to add files to your Zip file, then select the files you want 
to add and click OK.

4. Click Zip Now to create the new Zip file.

That's it, you've just created a Zip file using the WinZip Wizard. You can now click the WinZip Classic 
button if you would like to examine the contents of your new archive, or click Next to choose another 
activity within WinZip, or close the WinZip Wizard window.

Using WinZip Classic
Here is a brief introduction to some of the features of WinZip Classic.

Quick Unzipping with WinZip Classic
1. In the WinZip Window click the Open toolbar button, or choose Open Archive from the File 

menu. The Open Archive dialog box will appear.      
2. In the Open Archive dialog box you can locate the archive you want to unzip. Then click Open. 

The contents of the archive will be displayed in the WinZip window.
3. To extract files from the archive click the Extract toolbar button, or choose Extract… from the 

Actions menu. The Extract dialog box will appear. 
4. In the box labeled Extract to: choose the folder where you want to place the extracted files and 

click Extract.
That's it, you have extracted the contents of the archive to the chosen directory. You can now work with 
the extracted files, or choose another activity within WinZip, or close the WinZip window.

Note: You can also extract files from an archive in the WinZip Classic window by dragging them to the 
desired folder in Windows Explorer or to the desktop.

Quick Zipping with WinZip Classic
1. In the WinZip Window click the New toolbar button, or choose New Archive from the File menu. 

The New Archive dialog box will appear.      



2. In the New Archive dialog box you can specify the location where you want to create the archive, 
and type the name you want to use for your new archive. Then click OK. The Add dialog box will 
appear.

3. In the Add dialog box select the files that you want to add to your new archive and click Add.

That's it, you have created a new archive. You can now examine the contents of your new archive, or 
choose another activity within WinZip, or close the WinZip window.

Note: You can also add files to an archive by dragging the files from My Computer or Windows Explorer 
and dropping the files on the WinZip window.

WinZip Classic and Wizard: Switching Interfaces
You can easily switch between the WinZip Wizard and WinZip Classic Interfaces with a single mouse 
click. Here's how:

In WinZip Wizard click the WinZip Classic button at the lower left part of the Wizard panel to switch to 
the WinZip Classic Interface.

In WinZip Classic click the Wizard button at the upper right end of the WinZip Classic toolbar to switch 
to the WinZip Wizard Interface.

WinZip Classic Tips
You can view the contents of most files in an archive by just double clicking on them in the WinZip Classic
window.

You can extract files from an archive in the WinZip Classic window by dragging them to the desired folder 
in Windows Explorer or to the desktop.

Using the WinZip Classic Help menu, you can:
· work with the built-in Brief Tutorial to get acquainted with more of WinZip's features 
· view collections of Hints and Tips 
· find answers to Frequently Asked Questions

Zip and Unzip Files without Leaving the Explorer
To create an archive: you can select file(s) in Windows Explorer, right click, and choose Add to Zip from
the context menu that appears. 

To extract files from an archive: you can select the archive in Windows Explorer, and either: 
· right click and choose Extract to... from the context menu that appears, or 
· right click and drag the archive onto the folder where you want it extracted, and then choose an 

extract option from the context menu that appears.

Contacting Technical Support
You can contact our technical support staff as follows:

Internet: The best way to report problems on the Internet is with the support forms available from the 
"Support" link on the WinZip home page    at http://www.winzip.com. You can also send electronic mail to 
support@winzip.com.    We normally answer all questions within one business day. 

Postal Mail:    Write to Technical Support, WinZip Computing, Inc., P.O. Box 540, Mansfield, CT 06268, 
USA. 

Please include the following information with any technical support questions: 
· Is the problem reproducible? If so, how?
· What version of Windows are you running (for example, Windows 95 or Windows NT)?



· What version of WinZip are you running? If you are using the WinZip Classic Interface, choose 
About WinZip from the WinZip Help menu. If you are using the WinZip Wizard Interface, click the
About button on the WinZip Wizard Welcome screen. Please include the entire "version" line in 
your problem report.

· If a dialog box with an error message was displayed, please include the full text of the dialog box, 
including the title in the title bar.




